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Question Number : 1 Question Id : 51245213763 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

GIMP is an image editing tool.

1. Open Source

2. Proprietary

3. Shareware

4, Both (1) and (2)

Options :

51245242981. 1
51245242982. 2
51245242983. 3
51245242984. 4

Question Number : 2 Question Id : 51245213764 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

The tool allows you to select a drawing with the free-hand.

1. Fuzzy Selection
2. Lasso

3. Text

4. Bucket Fill

Options :



51245242985. 1
51245242986. 2
51245242987. 3
51245242988. 4

Question Number : 3 Question Id : 51245213765 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

tool helps you to add a new layer to the image which is identical copy of the active layer.

1. Smudge Tool

2. Dodge Tool

3. Perspective Tool
4. Duplicate Layer

Options :

51245242989. 1
51245242990. 2
51245242991. 3
51245242992. 4

Question Number : 4 Question Id : 51245213766 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

In mode, the selection is shown as a translucent screen overlying the image, whose
transparency at each pixel indicates the degree to which that pixel is selected.

1. Default

2. Quickmask

3. Marching Ants
4. Normal

Options :
51245242993. 1



51245242994. 2
51245242995. 3
51245242996. 4

Question Number : 5 Question Id : 51245213767 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Shift + C is the shortcut to the image.

1. Duplicate
2. Delete

3. Copy

4. Crop

Options :

51245242997. 1
51245242998. 2
51245242999. 3
51245243000. 4

Question Number : 6 Question Id : 51245213768 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

are the transparent sheets stacked one on top of the other.

1. Layers

2. Canvas

3. Windows

4. None of the above options

Options :

51245243001. 1
51245243002. 2
51245243003. 3



51245243004. 4

Question Number : 7 Question Id : 51245213769 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Scale option is used to change the of an image.

1. Colour

2. Size

3. Area

4. All of the above options

Options :

51245243005. 1
51245243006. 2
51245243007. 3
51245243008. 4

Question Number : 8 Question Id : 51245213770 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

By default, the extension of GIMP file is

1. .png
2. jpg
3. xcf
4, tiff

Options :

51245243009. 1
51245243010. 2
51245243011. 3
51245243012. 4



Question Number : 9 Question Id : 51245213771 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

What does selecting a layer mode do?

1. Copies the layers to all the other layers

2. Locks the layer so that it can't be changed

3. Changes the appearance of the layer or image based on underlying layers
4. Temporarily hides the layer from view

Options :

51245243013. 1
51245243014. 2
51245243015.3
51245243016. 4

Question Number : 10 Question Id : 51245213772 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Distort filters are used to do what to an image?

1. Create special effects

2. Fix out of focus images

3. Remove atmospheric distortion

4. Correct hues created by color filters

Options :

51245243017. 1
51245243018. 2
51245243019. 3
51245243020. 4

Question Number : 11 Question Id : 51245213773 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Transparency can be completely eliminated by

1. Adding an alpha channel

2. Adding a Layer Mask

3. Semi flattening the image

4. Removing the alpha channel

Options :

51245243021. 1
51245243022. 2
51245243023. 3
51245243024. 4

Question Number : 12 Question Id : 51245213774 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

How do you start the Paths tool?

1. Select the relevant icon in the toolbox

2. Use Tools -> Paths from the image menu
3. Use the hotkey B

4. All of the above options are correct

Options :

51245243025. 1
51245243026. 2
51245243027. 3
51245243028. 4

Question Number : 13 Question Id : 51245213775 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



How can you access help for an unfamiliar tool in a best way?

1. Select the help files index

2. Read the manual

3. Hover the mouse over the tool and press F1
4. Search the internet

Options :

51245243029. 1
51245243030. 2
51245243031. 3
51245243032. 4

Question Number : 14 Question Id : 51245213776 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

What purpose does the alpha channel serve?

1. Encodes information about layer transparency
2. It is the first channel in an image

3. Tells all the other layers what color to be

4. Sets the color index for every layer

Options :

51245243033. 1
51245243034. 2
51245243035. 3
51245243036. 4

Question Number : 15 Question Id : 51245213777 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Which tool do you use to trim unwanted information from a photo?

1. Use the Eraser

2. Use the Resize button
3. Use the Crop tool

4. Use the Trim tool

Options :

51245243037. 1
51245243038. 2
51245243039. 3
51245243040. 4

Question Number : 16 Question Id : 51245213778 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

How are the palettes accessed in GIMP?

1. By using the Palettes dialog

2. By typing Palettes with the keyboard
3. There are no palettes in GIMP

4. By clicking the Paths dialog

Options :

51245243041. 1
51245243042. 2
51245243043. 3
51245243044. 4

Question Number : 17 Question Id : 51245213779 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Why does the shape of the cursor change when inside the image window?

1. To blend in with the image

2. To stand out from the image
3. To make it easier to see

4. To indicate which tool is active

Options :

51245243045. 1
51245243046. 2
51245243047. 3
51245243048. 4

Question Number : 18 Question Id : 51245213780 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

What happens to the Undo History when an image is closed?

1. It is saved as a separate file

2. It is deleted

3. It is saved as a series of images

4. It is saved into the image metadata

Options :

51245243049. 1
51245243050. 2
51245243051. 3
51245243052. 4

Question Number : 19 Question Id : 51245213781 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



In a JPEG file, what happens if image compression is increased?

1. You have to use a decompressor to open the file
2. The file takes up more space

3. Image quality decreases

4. It takes longer to open the file

Options :

51245243053. 1
51245243054. 2
51245243055. 3
51245243056. 4

Question Number : 20 Question Id : 51245213782 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

What must you do to use an image produced in GIMP in another program?

1. Copy the file to the other program’s folder

2. You cannot use GIMP images in other programs
3. All programs support GIMP native format

4. Export a file format that the program can use

Options :

51245243057. 1
51245243058. 2
51245243059. 3
51245243060. 4

Question Number : 21 Question Id : 51245213783 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



What tools may be used to paint on a Quick Mask?

1. Only the Brush tool

2. Any drawing tool and the Bucket Fill tool
3. Only the eraser

4. Only the pencil tool

Options :

51245243061. 1
51245243062. 2
51245243063. 3
51245243064. 4

Question Number : 22 Question Id : 51245213784 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

How will you specify which portion of an image you want to modify?

1. Use the View Selection command

2. Draw a red circle around it

3. Use the Selection tools

4. Cut and paste the part you want into a new image

Options :

51245243065. 1
51245243066. 2
51245243067. 3
51245243068. 4

Question Number : 23 Question Id : 51245213785 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



The Fuzzy Select (Magic Wand) tool helps you to select areas of the

1. Canvas

2. All the layers

3. Current layer

4. Image with different colors

Options :

51245243069. 1
51245243070. 2
51245243071. 3
51245243072. 4

Question Number : 24 Question Id : 51245213786 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Preparing the image for the web means

1. Reducing the size of an image
2. Zipping the image

3. Crop the image

4. All of the above options

Options :

51245243073. 1
51245243074. 2
51245243075. 3
51245243076. 4

Question Number : 25 Question Id : 51245213787 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Where is the image displayed?

1. Canvas

2. Window
3. Scale

4. Bucket Fill

Options :

51245243077. 1
51245243078. 2
51245243079. 3
51245243080. 4

Question Number : 26 Question Id : 51245213788 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Which file format offers the best image compression?

1. .bmp

2. .png
3. jpg
4. None of the above options

Options :

51245243081. 1
51245243082. 2
51245243083. 3
51245243084. 4

Question Number : 27 Question Id : 51245213789 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



What is the shortcut key combination in GIMP to rotate an image?

1. Shift + C
2. Shift + F
3. Shift + R
4. Shift + T

Options :

51245243085. 1
51245243086. 2
51245243087. 3
51245243088. 4

Question Number : 28 Question Id : 51245213790 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Which mode is used for image file, when file size is of concern, or when you are working with images?

1. Indexed

2. Greyscale

3. RGB

4. None of the above

Options :

51245243089. 1
51245243090. 2
51245243091. 3
51245243092. 4

Question Number : 29 Question Id : 51245213791 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Which tool lets you select a freehand border and uses edge-recognition algorithms to better fit the border

around the object?

1. Scissor Select tool

2. Intelligent Scissor Select tool
3. Select tool

4. Intelligent Select tool

Options :

51245243093. 1
51245243094. 2
51245243095. 3
51245243096. 4

Question Number : 30 Question Id : 51245213792 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

What is the shortcut key combination in GIMP, to scale an image?

1. Shift + T
2. Shift + R
3. Shift + F
4, Shift + C

Options :

51245243097. 1
51245243098. 2
51245243099. 3
51245243100. 4

Question Number : 31 Question Id : 51245213793 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



What is the shortcut key combination in GIMP, to flip an image?

1. Shift + C
2. Shift + R
3. Shift + F
4. Shift + A

Options :

51245243101. 1
51245243102. 2
51245243103. 3
51245243104. 4

Question Number : 32 Question Id : 51245213794 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Which value of the resclution under print size for an image, results in very high quality?

1. 300 ppi
2. 100 ppi
3. 200 ppi
4. None of the above

Options :

51245243105. 1
51245243106. 2
51245243107. 3
51245243108. 4

Question Number : 33 Question Id : 51245213795 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



What is the use of cropping an image?

1. Fitting an image to fill a frame

2. Emphasize the subject

3. Removing a porticn of the background
4. All of the above

Options :

51245243109. 1
51245243110. 2
51245243111.3
51245243112. 4

Question Number : 34 Question Id : 51245213796 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

What is the default mode for image file in GIMP?

1. Indexed

2. Greyscale

3. RGB

4. None of the above

Options :

51245243113. 1
51245243114.2
51245243115.3
51245243116. 4

Question Number : 35 Question Id : 51245213797 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



What does the character "G” expand to in GIMP?

1. General
2. Generic
3. Grep
4, GNU

Options :

51245243117. 1
51245243118.2
51245243119.3
51245243120. 4

Question Number : 36 Question Id : 51245213798 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Google SketchUp keeps

1. Three windows
2. Five windows
3. Four windows
4, One window

Options :

51245243121. 1
51245243122.2
51245243123.3
51245243124. 4

Question Number : 37 Question Id : 51245213799 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



In Google SketchUp, Z-Axis indicates

1. Height
2. Length
3. Breadth
4. Depth

Options :

51245243125. 1
51245243126. 2
51245243127.3
51245243128. 4

Question Number : 38 Question Id : 51245213800 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Which is the Open Source Software?

1. Google SketchUp Make
2. Google SketchUp Free
3. Google SketchUp Pro
4. Google SketchUp

Options :

51245243129. 1
51245243130. 2
51245243131.3
51245243132. 4

Question Number : 39 Question Id : 51245213801 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



In Google SketchUp, Orbit Tool is used to rotate

1. Side of a Model
2. Top of a Model
3. Complete Model
4. All Axis

Options :

51245243133. 1
51245243134.2
51245243135.3
51245243136. 4

Question Number : 40 Question Id : 51245213802 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

In Google SketchUp, Eraser Tool effects

1. X-Axis

2. Y-Axis

3. Edges of a Model
4. Surface of a Model

Options :

51245243137. 1
51245243138. 2
51245243139.3
51245243140. 4

Question Number : 41 Question Id : 51245213803 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



In Google SketchUp, Push/Pull Tool works on

1. Curved lines

2. Straight lines

3. Flat shape

4. Smoothed surface

Options :

51245243141. 1
51245243142. 2
51245243143.3
51245243144. 4

Question Number : 42 Question Id : 51245213804 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

In Google SketchUp, which Key is to be used for Copying a Shape?

1. Alt Key
2. Tab Key
3. Ctrl Key
4. Shift Key

Options :

51245243145. 1
51245243146. 2
51245243147.3
51245243148. 4

Question Number : 43 Question Id : 51245213805 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



In Google SketchUp, Rotate Tool works for

1. Stretch

2. Copy

3. Array

4. All of the above

Options :

51245243149. 1
51245243150. 2
51245243151.3
51245243152. 4

Question Number : 44 Question Id : 51245213806 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

In Google SketchUp, we can create a Sphere with the help of

1. Triangle and Circle
2. Cube and Circle

3. Two circles

4. Rectangle and Circle

Options :

51245243153. 1
51245243154. 2
51245243155.3
51245243156. 4

Question Number : 45 Question Id : 51245213807 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



In Google SketchUp, which tool is needed for creating a Sphere

1. Rotate Tool
2. Eraser Tool
3. Offset Tool
4. Follow Me Tool

Options :

51245243157. 1
51245243158. 2
51245243159.3
51245243160. 4

Question Number : 46 Question Id : 51245213808 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

In Google SketchUp, Move Tool works for

1. Stretch

2. Copy

3. Array

4. All of the above

Options :

51245243161. 1
51245243162. 2
51245243163.3
51245243164. 4

Question Number : 47 Question Id : 51245213809 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



In Google SketchUp, Follow Me tool requires

1. A profile shape and a path

2. Only a shape

3. Only a path

4. No path and shape is required

Options :

51245243165. 1
51245243166. 2
51245243167. 3
51245243168. 4

Question Number : 48 Question Id : 51245213810 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

In Google SketchUp, Pan Tool is needed for Moving

1. Surface of a Model
2. Axis of Screen

3. Complete Model
4. Menu Bar

Options :

51245243169. 1
51245243170. 2
51245243171.3
51245243172. 4

Question Number : 49 Question Id : 51245213811 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



In Google SketchUp, to increase the segments of a Circle

1. Hold the Shift Key and hit the + key

2. Hold the Control Key and hit the + key
3. Hold the Alt Key and hit the + key

4. Only hit the + key again and again

Options :

51245243173. 1
51245243174. 2
51245243175.3
51245243176. 4

Question Number : 50 Question Id : 51245213812 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

In Google SketchUp, Offset Tool works for copying

1. A Model

2. Edges in a Plane
3. Optional Bar

4. Axis

Options :

51245243177. 1
51245243178. 2
51245243179.3
51245243180. 4

Question Number : 51 Question Id : 51245213813 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



In Google SketchUp, to stand a lying shape vertical, which tool is used?

1. Move Tool
2. Rotate Tool
3. Offset Tool
4. Camera Tool

Options :

51245243181. 1
51245243182. 2
51245243183.3
51245243184. 4

Question Number : 52 Question Id : 51245213814 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

In Google SketchUp, which one of the following is the Editing Tool?

1. Line Tool

2. Two point Arc Tool
3. Move Tool

4. Freehand Tool

Options :

51245243185. 1
51245243186. 2
51245243187.3
51245243188. 4

Question Number : 53 Question Id : 51245213815 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



In Google SketchUp, which is the Drawing Tool?

1. Polygon Tool
2. Scale Tool

3. Pan Tool

4. Orbit Tool

Options :

51245243189. 1
51245243190. 2
51245243191.3
51245243192. 4

Question Number : 54 Question Id : 51245213816 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

In Google SketchUp, which one of the following is Principal Tool?

1. Orbit Tool

2. Select Tool

3. Tape Measure Tool
4. Protector Tool

Options :

51245243193. 1
51245243194. 2
51245243195.3
51245243196. 4

Question Number : 55 Question Id : 51245213817 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



In Google SketchUp, Location of Measurement Box is at the

1. Top Right of the Screen

2. Top Left of the Screen

3. Bottom Right of the Screen
4. Bottom Left of the Screen

Options :

51245243197. 1
51245243198. 2
51245243199. 3
51245243200. 4

Question Number : 56 Question Id : 51245213818 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

In Google SketchUp, which are Camera Tools?

1. Pan Tool

2. Protector Tool
3. Scale Tool

4. Shadow Tool

Options :

51245243201. 1
51245243202. 2
51245243203. 3
51245243204. 4

Question Number : 57 Question Id : 51245213819 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



In Google SketchUp, a Polygon has

1. 6 Sides
2. 8 Sides
3.7 Sides
4. 9 Sides

Options :

51245243205. 1
51245243206. 2
51245243207. 3
51245243208. 4

Question Number : 58 Question Id : 51245213820 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

In Google SketchUp, a Circle has

1. 12 Sides
2. 15 Sides
3. 24 Sides
4. 18 Sides

Options :

51245243209. 1
51245243210. 2
51245243211.3
51245243212. 4

Question Number : 59 Question Id : 51245213821 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



In Google SketchUp, an Arc has

1. 6 Segments

2. 12 Segments
3. 15 Segments
4, 18 Segments

Options :

51245243213. 1
51245243214. 2
51245243215.3
51245243216. 4

Question Number : 60 Question Id : 51245213822 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

In Google SketchUp, Selection Tool selects the whole model by

1. Single Click
2. Double Click
3. Triple Click
4. Four Click

Options :

51245243217. 1
51245243218. 2
51245243219.3
51245243220. 4

Question Number : 61 Question Id : 51245213823 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



In Google SketchUp, which is a Construction Tool?

1. Tape Measure Tool
2. Walk Tool
3. Look Around Tool
4, Paint Tool

Options :

51245243221. 1
51245243222.2
51245243223.3
51245243224. 4

Question Number : 62 Question Id : 51245213824 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

In Google SketchUp, Walk Tool is a/an

1. Construction Tool
2. Shadow Tool

3. Edit Tool

4. Camera Tool

Options :

51245243225. 1
51245243226. 2
51245243227.3
51245243228. 4

Question Number : 63 Question Id : 51245213825 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



In Google SketchUp, Follow Me Tool is a

1. Drawing Tool
2. View Tool
3. Edit Tool
4. Principal Tool

Options :

51245243229. 1
51245243230. 2
51245243231.3
51245243232. 4

Question Number : 64 Question Id : 51245213826 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

In Google SketchUp, we can paint a house with

1. Construction Tool
2. Edit Tool

3. Paint Tool

4. Shadow Tool

Options :

51245243233. 1
51245243234. 2
51245243235.3
51245243236. 4

Question Number : 65 Question Id : 51245213827 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



In Google SketchUp, Paint Bucket is a/an

1. Edit Tool

2. Drawing Tool

3. Measurement Tool
4. Principal Tool

Options :

51245243237. 1
51245243238. 2
51245243239. 3
51245243240. 4

Question Number : 66 Question Id : 51245213828 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

How one can add a Mesh in Blender?

1. Shift A = Mesh

2. Shift A = Metaball

3. Ctrl A > Curve

4. Shift + Ctrl A > Mesh

Options :

51245243241. 1
51245243242, 2
51245243243.3
51245243244. 4

Question Number : 67 Question Id : 51245213829 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Pressing N in Blender will open the

1. Render window
2. Qutliner

3. Properties Region
4. Tool Shelf

Options :

51245243245. 1
51245243246. 2
51245243247.3
51245243248. 4

Question Number : 68 Question Id : 51245213830 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Cycles is a name assigned to which one of the following in Blender?

1. Painting tool

2. Render engine
3. Camera tracker
4. Sculpting tool

Options :

51245243249. 1
51245243250. 2
51245243251.3
51245243252. 4

Question Number : 69 Question Id : 51245213831 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



In Blender, to scale across “Y" axis, the shortcut is

1. SHIFT + Y
2.CTRL +Y
3. S(KEY) + Y
A SHIFT + CTRL + Y

Options :

51245243253. 1
51245243254. 2
51245243255.3
51245243256. 4

Question Number : 70 Question Id : 51245213832 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

How can you work with laptop (1 to 0) keys instead of using a numpad based keyboard?

1. File> User Preference> Input> Emulate Numpad

2. File> User Preference> Interface> Emulate Numpad
3. Edit> User Preference> Input> Emulate Numpad

4. Edit> Add-ons> Input> Emulate Numpad

Options :

51245243257. 1
51245243258. 2
51245243259. 3
51245243260. 4

Question Number : 71 Question Id : 51245213833 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Fill in the blank

In Blender, the modifier allows easy application of a simple deformation to an object.

1. Subdivision Surface

2. Solidify

3. Simple Deform Modifier
4. Simple Deform

Options :

51245243261. 1
51245243262.2
51245243263. 3
51245243264. 4

Question Number : 72 Question Id : 51245213834 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

For dealing with noise/fireflies in Blender, one may use

1. Subdivision Surface
2. Denoising

3. Solidify

4. Loop Cuts

Options :

51245243265. 1
51245243266. 2
51245243267. 3
51245243268. 4

Question Number : 73 Question Id : 51245213835 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



In Blender, the tool creates a cut through the whole loop you select, generating one or more new.

1. Mirror
2. Duplicate
3. Loop cuts
4. Render

Options :

51245243269. 1
51245243270. 2
51245243271.3
51245243272. 4

Question Number : 74 Question Id : 51245213836 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Which Lamp/Light is NOT supported in cycles render?

1. Spot Light
2. Point Light
3. Hemi Light
4. Sun Light

Options :

51245243273. 1
51245243274. 2
51245243275.3
51245243276. 4

Question Number : 75 Question Id : 51245213837 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



In Blender, one can medify the faces of mesh in

1. Object Mcde
2. Pose Mode
3. Edit Mode
4. Weight Mode

Options :

51245243277. 1
51245243278. 2
51245243279. 3
51245243280. 4

Question Number : 76 Question Id : 51245213838 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

In edit mode of Blender, press .............. to open Extrude Menu.

1. Alt +E
2. Ctrl +W
3. Shift +W
4. Ctrl +E

Options :

51245243281. 1
51245243282. 2
51245243283.3
51245243284. 4

Question Number : 77 Question Id : 51245213839 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



The shortcut for rendering in blender is

1. F12

2. CTRL+ ALT+ 0O
3. SHIFT + F12
4. F3

Options :

51245243285. 1
51245243286. 2
51245243287. 3
51245243288. 4

Question Number : 78 Question Id : 51245213840 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

In Blender, Boolean modifier performs . , and operations.

1. Difference, Union, Intersect
2. Difference, Multiply, Normal
3. Union, Multiply, Difference
4. Intersect, Multiply, Union

Options :

51245243289. 1
51245243290. 2
51245243291.3
51245243292. 4

Question Number : 79 Question Id : 51245213841 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



With , one can create complex materials in Blender.

1. Loop Cut

2. Node Cut

3. Node Editor
4. Weight Mode

Options :

51245243293. 1
51245243294. 2
51245243295.3
51245243296. 4

Question Number : 80 Question Id : 51245213842 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

In Blender, “X" key performs the operation of

1. Join selected objects, vertices or faces

2. Delete selected objects, vertices or faces
3. Edit two faces

4. Merge two faces in edit mode

Options :

51245243297. 1
51245243298. 2
51245243299. 3
51245243300. 4

Question Number : 81 Question Id : 51245213843 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



In Blender, “Numpad + period(.)" is used as shortcut for

1. Go to Selected Object
2. Camera View

3. Front View
4, Side View

Options :

51245243301. 1
51245243302. 2
51245243303. 3
51245243304. 4

Question Number : 82 Question Id : 51245213844 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

For Reset 3D Cursor the shortcut in blender is

1. Shift + C

2. Ctrl + C

3. Shift+ Ctrl + C
4. Alt+ Ctrl + C

Options :

51245243305. 1
51245243306. 2
51245243307. 3
51245243308. 4

Question Number : 83 Question Id : 51245213845 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Blender is a

1. Proprietary and paid software

2. Licensed and paid software

3. Free and open source 3D software
4. 2D and open source software

Options :

51245243309. 1
51245243310. 2
51245243311.3
51245243312. 4

Question Number : 84 Question Id : 51245213846 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

The first large professional project in which the free version of Blender used

1. Elephants Dream
2. Spider-Man 2

3. Big Buck Bunny
4. Batman

Options :

51245243313. 1
51245243314. 2
51245243315.3
51245243316. 4

Question Number : 85 Question Id : 51245213847 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



is an open source video game made by the Blender Institute.

1. Yo Frankie

2. Plumiferos

3. Sintel

4, Tears of Steel

Options :

51245243317. 1
51245243318. 2
51245243319.3
51245243320. 4

Question Number : 86 Question Id : 51245213848 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

the default render of Blender.

1. Cycles Render
2. Blender Render
3. Blender Game
4. LuxRender

Options :

51245243321. 1
51245243322.2
51245243323.3
51245243324. 4

Question Number : 87 Question Id : 51245213849 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Blender supports

1. Linux, Windows, and Macintosh systems

2. Windows, Android and Macintosh systems
3. Linux, Android and Macintosh systems

4. Linux, Android and Unix systems

Options :

51245243325. 1
51245243326. 2
51245243327.3
51245243328. 4

Question Number : 88 Question Id : 51245213850 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

In Blender, Shortcut to switch the view to the camera one is

1. Ctrl+C
2. R key
3.0 key
4.S key

Options :

51245243329. 1
51245243330. 2
51245243331.3
51245243332. 4

Question Number : 89 Question Id : 51245213851 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



In Blender, the part of a mesh where three or more vertices are joined together by edges is known as

1. Edges
2. Vertices
3. Nurbs
4, Faces

Options :

51245243333 1
51245243334. 2
51245243335.3
51245243336. 4

Question Number : 90 Question Id : 51245213852 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

In Blender, Red, Green, and Blue widget that appears with the Active Object is known as

1. Transform Manipulator
2. 3D Cursor

3. World Grid

4. World Nurbs

Options :

51245243337. 1
51245243338. 2
51245243339.3
51245243340. 4

Question Number : 91 Question Id : 51245213853 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



In Blender, to make an Edge Loop Selection one should

1. Press the SHIFT key and Right Mouse Button on the edge that needs to be selected.
2. Press the ALT key and Left Mouse Button on the edge that needs to be selected.

3. Press the SHIFT key and Left Mouse Button on the edge that needs to be selected.
4. Press the ALT key and Right Mouse Button on the edge that needs to be selected.

Options :

51245243341. 1
51245243342. 2
51245243343.3
51245243344, 4

Question Number : 92 Question Id : 51245213854 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

In Blender, perpendicular line drawn from out of the center of a face that represents the direction the face

is pointing is known as

1. Nurb
2. Normal
3. Edge
4, Face

Options :

51245243345. 1
51245243346. 2
51245243347.3
51245243348. 4

Question Number : 93 Question Id : 51245213855 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



In Blender, for making a border selection one should

1. Press the B key on the 3D view, left click to start the selection and release to confirm it.

2. Press the Ctrl+B key on the 3D view, left click to start the selection and release to confirm it.

3. Press the Shift+B key on the 3D view, right click to start the selection and release to confirm it.
4. Press the B key on the 3D view, right click to start the selection and release to confirm it.

Options :

51245243349. 1
51245243350. 2
51245243351.3
51245243352. 4

Question Number : 94 Question Id : 51245213856 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

In Blender, an Armature is a

1. A mesh in rest position

2. The skeletal structure in rest position
3. A monkey head

4. A mesh in moving position

Options :

51245243353. 1
51245243354. 2
51245243355.3
51245243356. 4

Question Number : 95 Question Id : 51245213857 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



In Blender, Mesh Editing is used for

1. Manipulating the data of a mesh, or polygon-based object.
2. Adding a mesh, or polygon-based object.

3. Rotating a mesh, or polygon-based object.

4. Scaling a mesh, or polygon-based object.

Options :

51245243357. 1
51245243358. 2
51245243359.3
51245243360. 4

Question Number : 96 Question Id : 51245213858 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

In Blender, lines of connection between interconnected vertices are known as

1. Face
2. Vertex
3. Edge
4. Nurb

Options :

51245243361. 1
51245243362. 2
51245243363. 3
51245243364. 4

Question Number : 97 Question Id : 51245213859 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



In Blender,

1. Press the E key to extrude a selected face
2. Press the shift + E key to extrude a selected face
3. Press the O key to extrude a selected face
4. Press the S key to extrude a selected face

Options :

51245243365. 1
51245243366. 2
51245243367. 3
51245243368. 4

Question Number : 98 Question Id : 51245213860 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

In Blender, a single point in 3D space that forms the basis of a mesh is known as

1. Face
2. Vertex
3. Edge
4. Nurb

Options :

51245243369. 1
51245243370. 2
51245243371.3
51245243372. 4

Question Number : 99 Question Id : 51245213861 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Maodifiers in blender are used to

1. Modify a mesh or other object in some way.
2. Scale a mesh or other object in some way.
3. Add a mesh, or polygon-based object.

4. Rotate a mesh, or polygon-based object.

Options :

51245243373. 1
51245243374. 2
51245243375.3
51245243376. 4

Question Number : 100 Question Id : 51245213862 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

The shortcut for Duplicating Selected 3D Object in Blender is

1. Shift + D

2 Ctrl + S

3. Shift + Ctrl + D
4. Ctrl + P

Options :

51245243377. 1
51245243378. 2
51245243379.3
51245243380. 4



